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• MPEG-4 Video Player 
• MP3 & WMA Music Player 
• Photo Viewer 
• USB 2.0 Hard Disk
• Game player 

User Manual for ARCHOS Gmini™ 400 
Version 1.1

English Language User Manual

Please visit our website to download the most recent manual and software for this product.

Gmini™
400
Pocket Music / Photo / Games / Video
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Dear Customer,

ARCHOS thanks you for your choice of this exciting Gmini 400 product. 
With this beautiful device in your pocket, you can enjoy digital music, 
digital photos, games, or digital video anytime and anywhere. We are 
sure that your Gmini 400 will give you years of listening and viewing 
enjoyment. Of course you can always use it as a regular portable hard 
disk too for all your personal computer files.

This guide will explain to you the functions of the Gmini 400. Our 
engineers have packed this product with many functions and capabilities. 
The better you know how to use it, the more enjoyment you will get from 
it. Remember, with the Gmini 400, you can…

• Listen to MP3, WMA, or WAV music files
• Play a variety of 2D and 3D Mophun® video games
• Play MPEG-4 video files on the built-in screen, or to a television or video 

projector 
• View digital photos and make personalized slide shows
• Record music files directly into digital format from your hi-fi without a computer
• Use it as a voice recorder with its built-in microphone
• Store .DOC, .PDF, or any type of data file – it’s a portable hard drive too!
• Create music Playlists
• Copy Pictures or data from CompactFlash™ cards directly to the Gmini 

400 (may require a freely available plug-in from the Archos website).

We wish you many years of enjoyment from your Gmini 400 product. 
Please do register your product at our website www.archos.com/
register/products.html to ensure that you get access to our help line 
and to be informed of free software updates for your product.

Wishing you the best music, photo, gaming, and video experience,

The ARCHOS TEAM
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a Hard disk activity indicator (red)
b On indicator (green)
c Battery charger indicator (green) – blinks when the battery is fully charged

d On/Enter/Play/Go ► – Hold for 3 seconds to turn on the Gmini 400
e Move UP (also increases volume during media playback)
f Move DOWN (also decreases volume during media playback)
g Move LEFT (also plays previous song or fast reverse through a song or video)
h Move RIGHT (also plays next song or fast forward through a song or video)
i Game Control 1 (Function depends on game) [acts as Enter/Play when not 

in game mode]
j Game Control 2 (Function depends on game) [acts as Escape/Stop when 

not in game mode]
k Escape/Stop/Go back/Off - Hold for 3 seconds to turn off device
l F1 command or function
m F2 command or function
n F3 command or function
o Function button F1 – activates the on-screen function or command above it (l)
p Function button F2 – activates the on-screen function or command above it (m)
 Long press to switch display between built in screen and external TV
q Function button F3 – activates the on-screen function or command above it (n)

1 INTRO - Ports, Buttons and Connections 
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a Multiconnect adapter – allows for an analog audio input (Line In)
b Multi-connect jack – for headphones, AV cable, or FM Remote control 
 (optional accessory)
c Microphone – for making digital voice recordings 
d CompactFlash™ slot – Type I compatible 
e  USB 2.0 port (USB 1.1 compatible) to connect the Gmini 400 to your computer 
f Power Connector (Use only the supplied Archos power charger/adapter)
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Please take the time to read though this manual. There are many 
things that this device can do that you may not be aware of.

2.1 Plugging in the AC Adapter

• Use only the included ARCHOS charger/adapter.
• Before using for the first time, charge the batteries completely.
• You may use the Archos Gmini 400 while its battery is charging, but it 

will then take longer before the battery is completely charged.

2.2 Turning on the Gmini 400

• Hold the PLAY/ON button ► for 4 seconds. The green “On” 
indicator light will turn on. Be patient, it will take a few seconds for the 
operating system to boot up.

• If the unit shuts off after holding the ON button for several seconds, plug 
in the Archos adapter/charger to make sure the batteries get charged.

2.3 Shutting off the Gmini 400 and Battery saving features

To shut off the unit, press and hold the STOP/ESC/OFF button for 3 seconds.

In the Power menu [Setup  Power: Battery Operation] 
there is a Power Off parameter. It is factory set to 2 
minutes. Thus, if your Gmini 400 is idle for 2 minutes, it 
will shut off. This setting can be changed from one to nine 
minutes or to ‘never’.
In the Power menu [Setup  Power: Battery Operation] 
there is a Backlight Off parameter to save battery power 
(the lighting of the screen consumes a lot of the battery 
power). It is factory set to 30 seconds. That is, if there are 
no buttons pressed, the screen will shut off in order to save battery life. 
To turn the screen back on, just click once on any button. See section 14.5 
for a complete explanation.

2 INTRO - First Time Usage 
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2.4 Changing the Language

The Gmini 400 interface can be set to English (default), French, German 
or Spanish.

• To change the language, move the cursor to Setup and then 
click PLAY/ENTER ►.

• Then move with the joystick to Display and click PLAY/ENTER ►.
• Highlight the Language parameter.
• Use the Right or Left button to choose the desired language.
• Choose French, German, Spanish or English.
• The language displayed will change immediately.
• Click on the STOP/ESC button to exit this screen.

2.5 Foreign Character Sets

You have the possibility to display your file names, folder names, and 
MP3 ID3 tags in various character sets (ex: Korean, Japanese, Simplified 
Chinese, etc.). You can find the language files CodePage_name.4FZ 
in the font folder under /Data on the Gmini 400 hard disk or on the 
Archos website under the heading Software. If, for example, you would 
like to have the Korean language display, then you would copy the file 
CP949.4FZ into the folder /system on the Gmini 400 and shut down and 
restart the Gmini 400. File names, folder names, and ID3 tags written 
using the Microsoft® codepage for the language will now be displayed in 
that character set. Only one .4FZ can be used at a time, thus you should 
only put one .4FZ file into the /system folder. When an .4FZ language file 
is used, the interface language will be set to English.

2.6 Charging the Batteries 

Use ONLY an Archos charger/adapter that is specified for the Gmini 
400. Other chargers or adapters may damage the Gmini 400. The green 
CHARGE indicator lights up to indicate that the external adapter is 
connected. The batteries will charge automatically when the AC adapter/
charger is plugged in. Once the batteries are fully charged, this light 
will blink, indicating that you can disconnect the charger/adapter. Once 
charged, you can get up to 10 hours* of MP3 music playback time and 
up to 5 hours* of AVI video playback time (on the built-in screen) from 
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the batteries. The Gmini 400 is made with integrated batteries which are 
designed to last for the life of the Gmini 400. This means that you will 
not have to change them. If, in the exceptional case, the batteries need 
changing, this should only be done by an Archos technician.

* depending on how you use it (start/stop/writing, etc.) 

2.7 Caring for the Gmini 400

The Archos Gmini 400 is an electronic product that needs to be treated 
with more care than typical consumer electronic products.

• Do not subject it to shock.
• Do not subject it to heat. Keep it ventilated (especially when connected 

to a computer).
• Keep the Gmini 400 away from water and excessively humid areas.
• Keep the Gmini 400 away from high electromagnetic fields.
• Keep any connected cords to the Gmini 400 neatly arranged. This light 

product could fall if a cord is accidentally pulled by a child.
• Do not open up the Gmini 400. There are no user serviceable parts 

inside. Opening will void your warranty.

2.8 Hardware Reset

In the event that your Gmini 400 freezes operation (due to electrostatic 
phenomena for example), you can actuate a hardware reset by holding 
down on the STOP/ESC button for 10 seconds. In normal operation, the 
STOP/ESC button will shut down the Gmini 400 after being held down for 
3 seconds.
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When you click on this icon in the main screen, you will be 
sent directly to the Music folder. Use the direction buttons 
to highlight one of the factory installed music selections and 
then Click on PLAY ►. If you hear nothing at fi rst, make sure 

you have adjusted the volume control on the headphone cord. By clicking 
on the Music icon in the main menu screen, you will enter into a ‘music 
only’ mode. Other playable fi le types that may be in this folder are only 
listed if you enter the folder via the Browser.

 Current Directory  Play Order  Play Mode: One Directory  Status: Playing  Volume (maximum:31)

Artist* or parent folder

Album* or current folder

Song title* or fi le name

Next track to be played

Relative location in the track 

Song elapsed time

Song time remaining

Song Length

Battery level (full)

Time of Day

File format and rec info

*APIC Album picture

Volume level meters 

  Go to setup options  Show Music Options  Browse the hard disk for other tracks 

*If the MP3 fi le contains these ID3 tag data

3.1 Button Control

Play/pause/resume song Increase the Volume

Click once: Play the previous song 
in the folder or playlist (during fi rst 
5 seconds of song) otherwise go to 
the beginning of the song.

Hold: Fast reverse 
through the song.

Click once: Play the next song 
in the folder or playlist.

Hold: Fast forward through the 
song.

 Stop Song  Decrease the Volume

3 MUSIC - Playing Music Files 
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To lock the Gmini 400 buttons, press and hold 
the left function button for three seconds. The 
Gmini 400 will display the message “Buttons 
locked!” on the bottom of the screen. Press this 
again for three seconds to unlock the buttons. 

What the Icons indicate

Status Play Order Play Mode

 Stopped  - no icon -
 Play once

See section 14.2

 Blinks while playing 
a track  Repeat playing

 Current track is 
paused

 Shuffl e (random) 
track selection

 Recording a track  Playing a playlist 

3.2 Playing Through your Stereo System

On your HiFi there are two RCA type 
connectors that are labeled Aux in, CD 
in, or Line-in. Typically they are color 
coded white and red for left and right 
stereo channels respectively. Just take the 
included A/V cable and plug it into the 
Gmini 400 headphone jack. Plug the red 
and white connectors into the Aux in, 
CD in, or line-in of your stereo system. 
Do not plug the yellow (video) connector 
into anything. On the front of your stereo, 
select the corresponding auxiliary input 

or CD input that you plugged into on the back of your HiFi system. Press 
Play and then adjust the Gmini 400 volume (UP/DOWN buttons) in order 
to supply your stereo system with a signal that is neither too weak nor 
too strong. If the sound is distorted, you will need to reduce the Gmini 
400’s volume.
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3.3 Artist, Album, Title … ID3 Tags

ID3 Tags are information about the recording 
which found inside of an MP3 music file. When 
someone creates an MP3 music file, he or she 
has the option of adding information to it. This 
information can include, among other things, the 
name of the artist (Wes Burden), the album name 

(Brave New World), the title of the song (Mirror), and a small image of 
the album cover (only jpeg images not progressive jpeg). If these data 
are present, the Gmini 400 will display them on the screen when it plays 
the file. If they are not present, then the Gmini 400 will display in order, 
the name of the parent folder, the name of the current folder, and then 
the name of the file.
As of the writing of this manual, there are two versions of ID3 tags that 
are firmly established standards, ID3 version 1 and ID3 version 2. Your 
Gmini 400 can read either version of tags, and display the information. If 
both sets of tags have information, the data from the ID3 version 2 tag 
will be displayed. Other tag information may include year and genre of 
music. These other tag data are not displayed by the Gmini 400, but are 
used to index your music in the ARCLibrary (see next section). WMA files 
also have tags and these are displayed as well when the file is played.

3.4 The ARCLibrary (Browsing by Album, Artist, or Song name)

The ARCLibrary is a system for choosing 
your music by its characteristics. It can 
be turned On or Off in the settings 
from Setup > Playmode. As shown 
in this screen capture, you can select 
your music by Artist, Album, Song Title, 
Genre, or Year. MP3 and WMA music 
files have internal data tags to hold 
information about the song. For MP3 
files, these are known as ID3 tags. Not 

all MP3 files have all this information filled in. If you purchase a song from 
a music download service, the songs will have this information. If you 
have an MP3 or WMA file without this tag information, then you can add 
or change it by going to the properties of the file in Windows® Explorer. 
Once you re-index the ARCLibrary, you will have access to this track 
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from the ARCLibrary. Audio files created 
with the microphone will be indexed as 
Artist = ARCHOS and Album = Audio 
Recording. The ARCLibrary indexes all 
the music and playlists that it finds in 
the folders Music and Playlists on 
your Gmini 400’s hard drive, by using 
the tag information in each song. When 
you transfer music to your Gmini 400 

from your computer, it goes directly to the Gmini 400 hard disk without 
the ARCLibrary knowing about the new song. Thus, in order for your new 
songs to be indexed into the ARCLibrary, you must update it with the 
Update button as shown here in the Setup > Playmode screen. You 
have the following options to set the ARCLibrary.

Off – From the Music icon, you will just browse music files in the folder Music.

On – You can browse music by its characteristics (ID3 tags) but you will 
have to manually update the ARCLibrary each time you add new music 
from your computer to your Gmini 400.

Automatic – The ARCLibrary will be set to On and it will automatically 
update the library each time it notices that you have disconnected from a 
computer. A message screen will appear indicating that it is updating the 
ARCLibrary contents.

3.5 Setting a Bookmark

If you are listening to a song, or perhaps a long recording, and 
would like to place a bookmark in it in order to pick up from 
this point at another time, you can use the Bookmark function. 
You simply click on the center function button labeled Options, 

then choose Set Bookmark. This will set a 
bookmark in the audio file at the current 
position. You can only set one bookmark 
per file. When you look at the file in your 
browser, it will have a yellow check mark 
on its icon indicating that this file has a 
bookmark set within it. You can have a 
maximum of 16 files bookmarked. Setting 
more bookmarks will then start to erase 
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the oldest bookmarks. The next time you play the audio file, you will be 
presented with three options:

Resume: Start playing from the bookmarked position.

Ignore: Keep the bookmark but start playing from the very beginning.

Clear: Clear the bookmark from this file and start playing from the 
very beginning.

3.6 The Resume Function

When you turn on your Gmini 400 you will sometimes notice 
that the icon which is highlighted on the main screen is not the 
Browser but rather the Resume icon. This icon is highlighted when 
the Gmini 400 can resume the last played audio or video file.
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4 MUSIC - Playlists 

A Playlist is a list of songs that the Gmini 400 will 
automatically play one after the other. The Gmini 
400 can load one playlist at a time into its internal 
memory. You can create new playlists, add or delete 
songs from a playlist, or Save a playlist as a fi le (fi le 
type .m3u) to be used another time. There is no 
limit to the number of playlists you can save on the 

Gmini 400 hard disk. Playlists are indicated by a special list icon (circled 
icon to the left).

4.1 Playing a Playlist

To play a Playlist, you simply scroll to the 
Playlist, such as ‘Jazz Music’ shown to the 
left, and click on PLAY ►. The list of songs 
will be loaded into the internal memory of 
the Gmini 400 and then be displayed in a 
separate panel.

Click on PLAY ► and the songs will 
be played in the order shown. To 
shuffl e the music entries in a random 
order, you can click on Playlist (F1), 
then choose Shuffl e. You can open 
a Playlist fi le (Playlistname.m3u) on 
your computer with a text editor such 

as Notepad, and you will see that it is merely a list of fi les to be played 
along with the hard disk path to fi nd them. If you delete a Playlist from 
your Gmini 400, you are only deleting the list and not the music itself. 

Example of the contents of the .m3u Playlist fi le ‘Jazz Music’.
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4.2 Creating a Playlist

To create a Playlist, press the RIGHT 
button while you are in the Music 
browser. A second window will open 
on the right side to display the Playlist 
contents. You can now start adding 
songs to the current Playlist. In the left 
window, search for the songs you would 
like to add to your Playlist. Once the song 
is highlighted, click on the Add function 

button to add it to the Playlist. The song will be added to the Playlist and a 
small mark next to the music icon will be made to indicate that it is in the 
Playlist. Continue searching and adding songs in this manner until you are 
satisfi ed. You can also click the Add or Insert button when highlighting 
a folder. All the contents of the folder and its subfolders will be added or 
inserted into the current playlist.
You can jump back and forth between the browser and the playlist by 
clicking on the LEFT and RIGHT buttons. A Playlist can have a maximum 
of 5000 songs. We recommend that you save your Playlists.

4.3 Saving a Playlist

It is recommended that each time you 
create a Playlist, you save it to a separate 
folder called Playlists. These lists take 
very little space on your hard disk and 
if well named, give you easy access to 
your favorite songs. Go to the Playlist 
by selecting Music from the main menu 
and then click on the RIGHT button. 
You will then see the list of songs in the 

current Playlist. Click the function button F1 then choose Save. 

ATTENTION: Make sure that your left window is the Playlists folder, 
because the open window on the left is the location the Gmini 400 will be 
saving your Playlist to.

Save – Saves the current playlist to the folder open in the left window. The 
* next to the playlist name indicates that this playlist has not been saved.
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Close – Closes the windows and returns to the main menu screen.

Rename – Renames the current playlist.

Shuffle – Randomly shuffles the order of the songs in the current playlist.

Clear – Clears the contents of the current playlist.

Button Move – Allows you to change the place in the list of the highlighted 
song. Click on Move and then click on UP or DOWN to move the song up 
or down the list. Click OK when finished.

Button Delete – Will delete the highlighted song from the Playlist. It will 
not delete the actual song itself from your hard disk, just from the current 
Playlist. 

Important: Once you save a Playlist it is important that you do not move or rename the 
actual MP3 files as the Playlist searches in the original file location. If you need to move your 
MP3 files to a different folder, you’ll have to recreate your Playlist.

4.4 Adding songs to a Playlist while listening to Music

This can only be done if you have entered your Music folder via the Music 
icon  and not by the general browser. To add the song you are listening 
to or any other song to the current Playlist, do the following:

• While playing a song, click on Options and choose Edit 
Playlist. A browser window and the Playlist will open.

• Click on the LEFT button to go to the hard disk browser 
window.

• Select the song or folder of songs to add, then click the 
button Add. 

• Click ESC to return to the playing screen.
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With the Gmini 400 series, you do not need a computer to create digital 
music files. It is capable of recording from the built-in microphone or 
an analog line source (ex: HiFi system, Boombox, CD Player, etc) into a 
standard Windows® WAV format, either PCM (uncompressed) or ADPCM 
(compressed). 

5.1 Cable Connections for Audio Recording

Plug the multi-connect adapter into the Gmini 400 and then plug the 
included AV cable into the side marked Line-In as shown here. Connect 
the Red (Right) and White (Left) connectors to the audio output of your 
Hifi or other audio device that you are recording from. Do not plug the 
yellow connector to anything.

To the outputs of your audio 
device.

5 MUSIC - Recording Music
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5.2 Recording Procedure

Before the actual audio recording begins, there is a pre-recording screen 
which will allow you to adjust your recording settings.

1. From the home screen, select Audio-
Corder then click on ENTER/GO ►. 

2. In the pre-recording screen, adjust 
the recording level* by clicking on 
the LEFT and RIGHT buttons. Click on 
the F3 Start button to start recording. 
Attention, the first time recording you 
should adjust your Settings.

3. Click on Settings to reveal the re-
cording parameters screen as shown 
above. Be sure to set the correct 
Source. You will hear silence during 
recording and playback if the incorrect 
source is chosen.

4. Once you have clicked on the Start 
button, you can pause the recording by 
clicking the same function button (now 
labelled Pause), or stop the recording 
by clicking on the STOP/ESC button.

* (Analog recordings only) You should try some test recordings before deciding on which 
recording level gives the best sound quality. Don’t be tricked by the volume of the 
headphones which can be adjusted independently with the UP and DOWN buttons.
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Microphone

The built-in microphone is located on the top of the Gmini 400 unit next 
to the headphone jack. Make sure that you have selected Microphone 
as the input source in the pre-recording Settings screen. The microphone 
recording level is preset.

Analog Line-In

You can record from any line-level audio source to the Gmini 400. Make 
sure that you select the Analog Line-In as the input source in the pre-
recording Setup screen. If you have the TV cradle unit, you can plug the 
Red and White connectors of the AV In cables to the output of you home 
stereo system or the audio device you are recording from. If you have the 
optional multi-connect adapter plug, you can enter a stereo audio signal 
into the AV400 directly. Be careful that the source audio is supplying a line 
level and not an amplified signal (turning down the volume on the player 
will work if you are using the headphone out signal of your audio device). 
An amplified signal will make for a terribly distorted recording. You can 
also use a high quality pre-amplified microphone, such as the one Archos 
sells as an option.

Incremental Recording

While recording, you will notice the center function button 
labeled Next. This allows you to create incremental recordings. 
That is, the current recording stops and a new recording 

instantly begins. The next recording has an additional number appended to 
its name. Thus if you create multiple incremental recordings, you might, for 
example, have files names of REC0000_01, REC0000_02, etc. This is good 
for recording old cassettes and old vinyl records. You can click on the Next 
button during the blank space between each song. That way, each song of 
the vinyl disk or audio cassette will be one single audio file.

5.3 Where is the Recording Saved?

The default location for audio recordings is the folder called Music. If you 
click on the Music icon in the main menu, you will go to this folder. Notice 
that the right function button is labeled Record. Each time you use this 
button to record audio instead of the AudioCorder button on the main 
menu, you set the recording default location to the current folder. For 
example, let’s say you have a folder called /Music/Voice/Lectures. If you 
go to this folder and then make a recording using the right function button 
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Record, you will set the default record location to this folder. Now, each 
time you use the AudioCorder icon to start a recording, your recording will 
be saved in the folder /Music/Voice/Lectures.

5.4 Audio Editing

Audio fi les (microphone recordings / analog recordings / FM Remote 
Control (optional)) can be modifi ed by deleting the sections you do not 
wish included. If you would like to edit an audio recording, you have the 
possibility to “crop out” the exact section of the recording you would like 
to save. For example, you have recorded a lecture of 33 minutes and 22 
seconds in length. You would like to cut out and save just one particular 
important section from 12 minutes and 15 seconds to 21 minutes and 5 
seconds. The diagram below illustrates the situation.

Desired audio section 

00:00 (0min 0sec)  12:15  21:05  33:22

To keep just this section (cropping it), you will:

• locate this fi le from the Browser mode
• Select Edit from the File menu in order to enter the edit mode
• In the edit mode, set the cut-IN point (12:15 in our example)
• Next, set the cut-OUT point (21:05 in our example)
 Save the edit
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Highlight the file to edit and select 
Edit from the file menu. Only files 
which have been created with the 
Gmini 400 recording function will 
show Edit in the file menu. Files 
created from CDs or downloaded 
cannot be edited. Once you enter 
the edit mode, the audio file will 
play in a continuous loop so that 
you will be able to hear how your 
edit sounds.

Use the fast-reverse and fast-
forward buttons (LEFT/RIGHT 
buttons) to locate the points you 
want the new file to start and end. 
These are the cut-IN and cut-OUT 
points. Once you have set these 
points, you can save the edit. In this 
example, a new file REC0000.wav 
will be made. Your original file is 
left untouched. You will notice that 
your Cut-IN and Cut-OUT times are 
marked just above the file name.
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6 MUSIC - Using Windows® Media Player 9 

The Gmini 400 is designed to work seamlessly 
with Version 9 of Windows® Media Player 
(WMP9). By installing the Archos Service 
Provider plug-in, WMP9 will recognize your 
Gmini 400 as a connected music device. You 
can then easily copy your CD collection to 

your Gmini 400. WMP9 will encode each song into the WMA format 
(preferred compressed format of Windows®) and then store them on your 
connected Archos device. This Service Provider plug-in will also allow you 
to play purchased music from on-line music services such as Napster.com, 
MusicNow.com, BuyMusic.com, and Liquid.com. 

6.1  Installing Windows Media Player 9

If you do not already have 
Windows Media Player version 
9 running on your computer, 
you can install it from the 
Archos Installation Utility. 
Connect your Gmini 400 to 
your computer. In Windows 
Explorer, open up the hard 
drive labeled JUKEBOX. It may 
be called JUKEBOX (E:) or 
with another letter. Open the 
folder Data, then the folder PC 

Installation, then double-click on the fi le Setup.exe. In other words, follow 
the path E:\Data\PC Installation\setup.exe. Click on the icon according to 
your operating system. Follow the on screen instructions.

6.2 Installing the WMP9 Service Provider Plug-in

You should fi rst make sure you have properly installed Windows Media 
Player 9 as explained above. To install the Service Provider Plug-in to 
Windows Media player, run the Archos Installation Utility as explained 
above, and then chose Archos Media Player Service Provider Plug-in. 
Follow the on screen instructions. If you have accidentally deleted it, 
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you can download it from 
the Archos website ‘software’ 
category (www.archos.com). 
With your Gmini 400 still 
connected to your computer, 
start Windows Media Player. 
Normally, you will connect 
your Gmini 400 to your 
computer before you run the 

WMP9 program. If you connect it after WMP9 has been started, you will 
have to click on View > Refresh in order for WMP9 to go check and fi nd 
the connected Gmini 400.

6.3 Copying Music to your Gmini 400

Run Windows Media Player. 

6.4 Copy Protected Music Downloads

With music download services such as Napster.com, MusicNow.com, 
BuyMusic.com, and Liquid.com, you can purchase music on-line and 
then store it on your Gmini 400. These music fi les are protected with the 
Microsoft® copy protection system. When they are downloaded to your 
computer then transferred to your Gmini 400, they will play only on your 
devices. These fi les will not play on other people’s computers nor on other 
people’s portable music players. 

1. Choose Copy to CD or Device and then check 
the songs from your Music Library that you want to 
copy to your device. 

2. Choose the Gmini 400 
device then select the folder 
you want to copy your songs 
to. Now click on Copy.



26

7 MUSIC - Using iTunes™ with your Gmini 400

The easiest way to transfer music files between a 
Macintosh® computer and your Gmini 400 is to use the 
Macintosh Finder™ to drag and drop the files to and from 
your Macintosh®.

However, for Macintosh® users who do want to use the 
Gmini 400 with iTunes®, Archos has developed a special 

i-Tunes® plug-in. You will find it in the folder /Data/i-Tunes Plug-in on 
the Gmini 400 hard disk or from the Archos website. In this folder you 
will find a .sit compressed file. Uncompress it and open the folder for your 
operating system. You will a find a JPEG image illustrating where you need 
to copy the plug-in to. Once this is done, iTunes™ will recognize the Gmini 
400 as a ‘Device’. 

To make your user experience easy as possible, please keep in mind the 
following.

1) When you create your Playlists with iTunes® (you can only create 
Playlists from songs that have been copied to your Gmini 400), your 
Macintosh® will save these Playlists to the root directory of your Gmini 
400. It will not save them to the Gmini 400 Playlists directory. It would be 
best to use the Gmini 400 itself to make Playlists (section 4.2) and then 
save these Playlists in your Playlists folder.

2) When you drag and drop MP3 files from your iTunes® library to your 
Gmini 400, the i-Tunes® program will look at the ID3 tag information (See 
section 3.3 of this manual for an explanation of ID3 tags) of the MP3 file, 
and create a folder on the root of your Gmini 400 using the name of the 
Artist as the folder name. Then it will take the Album name ID3 tag, and 
create a subfolder with that album as its name. Finally, it will take the MP3 
song itself and place it into that album subfolder. Thus, although it is a 
clean structure of artists and albums, i-Tunes® does not follow the Gmini 
400 convention of placing the music into the Music folder first.
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8 GAMES - Playing Mophun® games

Your Gmini 400 has a built-in Mophun® game engine. What that means is 
that it can run games created for the Mophun® gaming platform. Included 
with your Gmini 400 is the full version of one of the game titles available 
from Archos. You will also find other sample games on your Gmini 400. 

8.1 Downloading Games

To see a complete list of games for sale, 
go to the Gmini 400 presentation page 
on the Archos website (www.archos.com) 
and click on the Gmini 400 Games link. 
Once you purchase the game, you will 
be presented with a download message 
box. Your browser may warn you that the 
contents of the download may harm your 
computer. This is because the Windows® 

system does not know what a .MPN file is. Be assured that Archos has 
made every effort to ensure that the file does not contain viruses. Click on 
the option Save to download this file to a convenient place, such as My 
documents, in order to later copy this file to your Gmini 400.

Copy to Gmini 400 root

Connect your 
Gmini 400 to your 
computer (section 
13.1), and then 
copy the .MPN 
game file to the 
root directory of 
the Gmini 400. The 
root directory is the 

top most level of the directory hierarchy. Just drag this .MPN file onto the 
Gmini 400 Hard disk in your file manager and it will place it in the top most 
directory (outside any folder). Once this file is copied, safely disconnect 
(section 13.2) the Gmini 400 from the computer.
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Once disconnected from your computer, the Gmini will notice that there 
is a new game file on the root directory and will install the game 
automatically. It will then erase the .MPN file that you copied to the root 
directory. It is a good idea to keep a copy the installation file on you PC. 
Even if that file gets lost, you can always go back to the Archos website 
and re-download your purchased game free of charge.
You may notice that there is a folder on your Gmini 400 hard drive called 
Mophun. You should not delete this folder nor copy any files into it. 
Purchased games will install themselves into this folder.

8.2 Playing a Game

Just highlight the Games icon in the main screen and 
click the Go button. You can choose from the list of 
games presented. Once selected, follow the on-screen 
instructions.
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9 VIDEO - Playing Video 

Like a music file, you simply highlight the video file and 
then click on PLAY/GO ►. The thumbnail images on the 
right side will show you a frame from the highlighted video 
file (center) as well as a frame from the file above and the 
file below the highlighted one. By clicking on the Video icon 
in the main menu, you will enter into a display ‘video only’ 
mode. Other playable file types that may be in this folder 

are only listed if you enter the folder via the Browser.

To watch your videos on a television, 
you must hold down the F2 function 
button (the center function button) for 
three seconds. The Gmini 400 screen 
will go black and the video will be 
sent out to your connected television. 
Switch your television to auxiliary video 
input (often found just below channel 
1 – sometimes called L1 or L2). If you 
don’t see a clear color image, you may 
have to set your Gmini 400 to your 

local television standard (NTSC or PAL) in the Setup > Display settings 
menu.

• Use the PLAY/GO ► button to pause/resume the video. 

• Use the UP/DOWN buttons to control the volume.

• Hold down the RIGHT/LEFT buttons to fast forward or 
fast reverse through the video.

• Click the right function button to Hide/Show the overlaid video time 
information.

• Click the Options function button to set a bookmark, change the screen 
presentation. Long press to switch between built-in video and external 
video. 
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• Click on the left function button 
to put the video into slow-motion 
view. You can cycle through the 
values Normal, ½ , ¼ , and 1/8 
speed. The sound is muted when 
in slow motion. While in slow mode 
and paused, you can step image per image with the RIGHT button.

9.1 Setting a Bookmark

If you are watching a video and would like to place a bookmark 
in it in order to continue from this point at another time, you 
can use the Bookmark function. You simply click on the center 

function button labeled Options, then choose Set Bookmark. This will set 
a bookmark in the video file at the current position. You can only set one 
bookmark per file. When you look at the file in your browser, it will have a 
yellow check mark on its icon indicating that this file has a bookmark set 
within it. You can have a maximum of 16 files bookmarked. Setting more 
bookmarks will then start to erase the oldest bookmarks. The next time 
you play this video file, you will be presented with three options:

Resume:  Start playing from the bookmarked position.

Ignore:  Keep the bookmark but start playing from the very   
 beginning.

Clear:  Clear the bookmark from this file and start playing from the  
 very beginning. 

9.2 The Resume Function

When you turn on your Gmini 400 you will sometimes notice 
that the icon which is highlighted on the main screen is not the 
Browser but rather the Resume icon. This icon is highlighted 
when the Gmini 400 can resume the last played audio or video 
file.
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9.3 Display Format Settings

You will notice in the Options button (center function button), that you 
have a number of display format options. In certain cases, depending 
on how the original video was recorded, you may want to use these 
adjustments.

Default mode : Adjusts the video size to best adapt to the LCD screen.

4/3 aspect: Enlarge the image to fill the screen (usually a vertical fill) and 
then cut the sides to completely fill a television screen.

16/9 aspect: Send out a TV signal without the black horizontal bars. 

No Overscan: Picture will not pass into the overscan area. Entire picture 
will always be seen on all televisions. Will not be cropped on the LCD.

9.4 Playing Video Files from the Internet

The number of encoding and compression schemes currently used to 
create video files is very extensive and seems to change on a weekly 
basis. There are so many standards and formats that it is very possible 
that the video file you download from the Internet will not play right away 
on your device. Due to certain “variations”, even when video files are 
formatted in “MPEG4” they may not play right away. The Gmini 400 series 
can play video files of type MPEG4 Simple Profile which have an MP3 or 
IMA-ADPCM audio sound track. It can play such video files which have a 
maximum size of 640 x 400 pixels (30 frames/second). The Gmini 400 will 
not directly play files of type .mov, .mpg, .mpeg, or .avi files created with 
codecs (compression/decompression) other than the XviD and DivX™ 
MPEG4 codecs. If you have video files of these other types that you would 
like to view on your Gmini 400, they will have to be converted first. You 
will have to use the software MPG4 Translator included on the Gmini 
400 hard disk to re-encode them into the proper XviD or DivX™ MPEG4 
format with an MP3 or IMA-ADPCM sound track. See chapter 10 for more 
details.
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How to create an MPEG-4 video file

Please understand that video re-encoding is not always a simple one button 
process. Video segments that come from your digital camcorder or which 
are freely available on the Internet are encoded in many different ways. If 
not already in the proper MPEG4 Simple Profile format, transforming these 
videos into this format readable by the Gmini 400 requires use of the below 
mentioned software tools. This is due to the relatively new nature of the 
ISO (International Standards Organization) MPEG4 video format. Unlike 
its predecessors MPEG1 and MPEG2, there are a number of levels in this 
format and thus not all MPEG4 video files will work on all MPEG4 players, 
and older MPEG1 and MPEG2 files must be re-encoded into this format. 
Although you may have a bit of a learning curve in the initial re-encoding 
of video files, once you have the process down, it is just a matter of letting 
your PC or Mac go to work and create video files for playing on your Gmini 
400.

PC Tools 

The Gmini 400 is delivered with two Windows® based programs that allow 
you to create MPEG4 Simple Profile .AVI video files. They are the MPG4 
Translator and Virtual Dub™. The MPG4 Translator will call the Virtual Dub 
program and give it the correct parameters to encode your video from its 
original format, .avi or .mpg (mpeg 1), and then encode it into a DivX™ 
based MPEG4 .AVI file. The file will be scaled in order to be played back 
properly. Only MPEG4 files encoded with DivX™ or XviD can be played on 
the Gmini 400. Please visit the website of DivXNetworks, Inc (www.divx.
com) to download this codec. This is a free codec. This will allow your PC 
to create DivX™ type videos which play on your Gmini 400. If you would 
like to have your sound track in MP3 format, you may have to download 
this audio codec (available freely on the Internet) if it is not already on your 
computer. 

Macintosh Users 

Until recently, the Macintosh user community did not have any tools to create 
DivX™ simple profile MPEG4 video files. There are now tools available for 
purchase at the DivX™Networks web site which will allow you to create DivX™ 
simple profile files with your Macintosh that are playable on the Gmini 400. 

10 VIDEO - Creating MPEG4 video files with your computer
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10.1 Installing the PC Software

If your video file is not an MPEG4 Simple Profile .avi file of the proper size, 
you will need to re-encode it using the following utilities. For the Gmini 
400, you will need to create an AVI file that is MPEG4 Simple Profile with a 
maximum resolution of 640 x 400 and a sound track that is stereo MP3 or 
WAV. Run the program SETUP.EXE (the Archos Installation Utility) found 
on the Gmini 400 hard drive in /Data/PC Installation. Please install the 
programs in the following order.

DivX™ Codec

This software will install the DivX™ Compression/Decompression onto 
your PC. You should shut off any anti-virus programs when installing this 
or other codec software. This is not a program that is run by itself. Rather, 
it installs background software which allows your computer to do high 
quality video compression. This is the MPEG4 compressed video type that 
the Gmini 400 knows how to play. You can find this codec software, as 
well as an application that allows you to play DivX™ videos on your PC, at 
the website www.divx.com. The standard version is the one best suited 
for your Gmini 400. If you do not use the standard version, uncheck the 
bidirectional encoding in your DivX codec property page.

Virtual Dub™

A utility for transcoding one video file into another. This is a general 
purpose transfer and cleanup utility which has many options allowing for 
even the most difficult video translations. When you install it with the 
Archos Installation Utility, it will automatically unzip. It will prompt you 
to save it to C:\Program Files\VirtualDub. You should use this default 
directory location. Otherwise you will have to instruct the MPG4 translator 
program where to find it.

MPG4 Translator

This program, developed by Archos, is a “Front-end” for the Virtual Dub 
program. It has a simple interface which you use and it then tells Virtual 
Dub how to process the video file. It sets all the parameters for Virtual 
Dub specifically to create a video file in the right size and format to be 
read by the Gmini 400. When you run it for the first time, the MPG4 
Translator will need to locate the Virtual Dub program. If you did not 
install Virtual Dub in the default location, you will have to show the 
program where Virtual Dub is.
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MP3 Sound Codec

If MPG4 Translator detects a suitable MP3 codec on your PC, it will use 
it, and your video file sound track will be MP3. Otherwise, it will use the 
standard IMA ADPCM codec. There are MP3 encoders (usually packaged 
together as an encoder and decoder) available on the Web for you to 
download. If you choose to use the LAME codec, make sure that you have 
a version built with the ACM front-end. You can find other MP3 codecs on 
the web by using the search terms ACM, MP3 and CODEC in your favorite 
web search engine. Once this MP3 codec is installed into your system, 
MPG4 Translator will be able to create final video files with MP3 sound, 
even if the source video file does not have an MP3 sound track.

If you are unsure what codecs (audio 
and/or video) have been installed on your 
computer, you can see the list by going to 
the following location. 
For Windows XP, click on Start > Settings 
> Control Panel > Sounds and Audio 
Devices Properties > Hardware > 
choose Audio Codecs, then click on 
Properties. You will find a list here of 
all the audio codecs that are installed on 
your computer. Decoding of MPEG 2 video 
files is currently not supported by MPG4 
Translator. These are usually .mpg or .mpeg 

format files, not the required AVI file. There are other tools found on the 
Internet (FlaskMPEG, Rippack, etc.) that may be downloaded in order to 
help you with these file types. A good starting place is the website www.
digital-digest.com.
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10.2 Using MPG4 Translator

Here you see the image of the main MPG4 
Translator program. When you fi rst run 
the program, if the DivX™ codec has not 
been installed yet, you will be notifi ed. You 
should download the codec and install it on 
your computer. If the Virtual dub program 
has not been installed, you will also be 
notifi ed, and you should install it (either 
with the Archos Installation Utility or the 
Virtual Dub website). If you have placed 
the Virtual Dub program in a folder other 
than the default, it will ask you to locate 
the fi le.

Select Source & Destination Files

In the example above, a source fi le 24 hours of Lemans.avi has been selected 
as the source video. You can see on the bottom of the window its original 
characteristics (width 720, height 576, frame rate 25). Next, you must then tell 
the program where to place (Set Destination fi le) the newly recorded version 
of the fi le (don’t worry, it will not erase the original). You should give it a new 
descriptive name, such as shown above Lemans_Gmini400.avi. Make sure you 
add the .avi extension.

Change Settings

Next, you can change the parameters (Change Settings) of the DivX™ 
encoder to adjust the level of quality of the fi nal image. Like MP3 music, 

the higher the bit rate setting is 
made, the higher the quality of the 
music, or video in this case, that 
you will get. However, this will also 
take up more space on your hard 

disk. A setting of 900 kbps will give you a nice looking image for viewing 
on a television. For near DVD quality, you can set it up to 1200 kbps. If 
you do not use the standard version, uncheck the bidirectional encoding 
in your DivX codec property page.
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Target & Priority

You should select the target as 
Gmini 400. You will see a Priority 
box appear. This control is to 
allow you to select which feature 
of the video to be guarded. If for 

example you are re-encoding a video file that is 800x600 in resolution 
and 30 frames per second, this is beyond the maximum resolution that 
the Gmini 400 can play. Thus, the MPG4 Translator program will have to 
decrease the resolution. Choosing LCD optimizes the final video format 
for viewing on the built in LCD screen. Choosing the TV option will 
optimize the movie to keep the highest possible frame rate. You can see 
what the size and frame rate will be by looking at the Video Image Size: 
Destination parameters. When choosing TV, it is understood that the 
output will be optimized for a television, and not the built-in screen.

Start

Click on Start and the program will call Virtual 
Dub to start processing the video. Depending 
on the power and speed of your computer, 
this could take real time (a 60 minute long 
video re-encoded in about 60 minutes) or 
much longer. As shown to the left, you will see 
the progress as it processes the video file. If 
the Start button is grayed out, it would be for 
one of two reasons. 1) The source file is not a 
true AVI file. Even if the file name ends with 
.avi, the internal file data determines if it is 
truly an AVI file. 2) The Virtual Dub program 
was not located when MPG4 Translator was 

started up. Close the program, restart it, and make sure you locate the 
Virtual Dub program.
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11 PHOTO - Viewing Photos

The Gmini 400 series support the viewing of JPEG (.jpg) and 
Bitmap (.bmp) image formats. Progressive JPEG images are 
not supported. The Gmini 400 will resize the image to fit on 
the built-in screen or on a television screen if you choose the 

television output. The yellow bar above the list of files indicates that you 
are in the ‘Photo Only’ mode, meaning that only files of type JPEG or BMP 
will be visible in the directory. The three images on the right are thumbnail 
sized pictures of the highlighted file (center) and the picture just before 

and just after the highlighted file.
If you are viewing photos on 
a television (long press on F2 
to switch to external video), it 
is recommended that you set 
the Image Display setting to 
Progressive to eliminate any 
possible screen flicker. You will 
find this in the menu Setup > 
Display.

11.1 Viewing Photos

When you click Enter ► on a highlighted image file, the Gmini 400 will 
display the image in the carrousel, either alone, within a group of 4 
images, or within a group of 9 images. A red rectangle will surround the 
selected photo. Click on Enter ► again to display the image in full screen. 
Once it is displayed as a full screen image, you can rotate it, magnify it, or 
set it as the Gmini 400 screen background (Wallpaper).

1 x 1 image 2 x 2 images 3 x 3 images
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Rotate picture 90° left

Rotate picture 90° right

View next photo

View previous photo

• Click the left function button #-Pic to change the number of photos in 
the carrousel view.

• Click the center function button Picture to display the picture options.

• Click on the right function button Hide to hide the picture name and 
function buttons.

Magnifying Photos

Once the picture is displayed in full screen, clicking the PLAY/GO button ► 
will magnify the image up to three levels. Each successive click of the 
PLAY/GO button will magnify the picture one more level. You can use 
your direction buttons to move the picture around in order to see the 
desired magnifi ed area. The small + signs on the bottom left of the screen 
indicate the level of magnifi cation, either +, ++, or +++. Click on STOP/
ESC to go back to an unmagnifi ed view.

11.2 Viewing a slideshow

By clicking on Slideshow, the Gmini 400 will 
present each picture in the current folder for 
a set amount of time and then go on to the 
next picture. You can set the amount of time 
that each picture stays on the screen under 
Setup > PlayMode > Picture Pause. This 
parameter is the number of seconds each 
picture displays on the screen.
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11.3 Transferring photos to your Gmini 400

To transfer pictures from your 
digital camera directly into 
the Gmini 400, you will insert 
your digital camera’s Compact 
Flash™ card* into the slot on 
the left side of the Gmini 400. 
Open up the door to the slot 
by unlatching the center clasp 
with your thumbnail.

*Attention: In order to protect the 
delicate pins in the CF card slot, 
the door to the slot only opens 
far enough to allow the CF card 
to enter. Do not force it to open 
further than shown in the photo 
here. 

Slide the card in with its front side 
facing the back of the Gmini 400. 

When you insert the card, the Gmini 400 will recognize it and open up 
two browser windows. The left window will show the contents of your 
CompactFlash™ (CF) card* and the right window will show the contents 
of your Gmini 400’s hard drive. Navigate to the folder on your CF card 
which contains your photos (in this example /DCIM/113CANON). Move to 
the right window (click the right button) and navigate to the folder you 
would like to save your photos to (you can create a new folder if you need 
to by clicking on the right window’s Folder (f3) button).
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Photos from CompactFlash™ on the 
left, and your Gmini 400 hard disk on 
the right. Choose destination folder 
then choose File > Copy All.

Your files will be copied to the folder 
on the right side of the screen. You 
can now pull out the CF card from the 
Gmini 400.

If your image files are not seen in the left screen, you may have to go the Setup 
> System > Show all files parameter and set it to On. Once set to on, all file 
types, regardless of their extention (.txt, .raw, .pdf, etc.) which are on your CF 
card will be visible in the left browser screen. You cannot copy files to your CF 
cards from your Gmini 400.

*If your camera uses SmartMedia™, Memory Stick® (MS), MultiMedia Card (MMC), 
or Secure Digital™ (SD) memory cards, you can purchase the optional Archos 
4-1 CompactFlash™ adapter which will allow these card types to be read by the 
Gmini 400.
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12 BROWSER - Using the Browser

The browser is used to navigate the fi le system on the Gmini 
400. The fi le system is FAT32, the same type of fi le system 
that is found on Windows® based computers. That is, it is a 
hierarchical system which includes folders and subfolders. 
Because you will be putting hundreds of fi les on your Gmini 

400, it is STRONGLY ADVISED that keep a neat and orderly fi le structure. 
Otherwise, you will be spending time searching for fi les and not listening 
or watching them. We suggest that on the fi rst level of your fi le structure, 
you include the folders: Data, Music, Playlists, Photo and Video.

The folders Music, Photo and Video are special folders in that the icons 
on the main screen lead to these folders and then places you directly in 
that folder. If these folders are deleted, you will be placed at the root level 
(highest level) of the directory hierarchy.

12.1 Navigating the Directory Structure

Just below the top status bar, you 
can see the path to the directory 
you are currently viewing. 

To navigate the directory structure you will use: 

ENTER ► Open the 
highlighted folder 
(directory) or Play the 
highlighted fi le.

Move the cursor up and 
down to the previous or 
next fi le or folder. 

ESC/STOP Go back to 
the main menu.

Move back and forth 
between windows in the 
double browser.
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Go to the parent 
directory (go back up one 
level). Example: Go from 
folder /Music/Wes 
Burden/ to /Music.

12.2 Navigating the Directory Structure

Depending on where you are in the directory system, you will have the 
option to manipulate fi les and folders. From the main menu, click on 
Browser. Attention, there is a setting in the Setup > System menu called 
Show all fi les. If this is set to Off, the Gmini 400 will only display fi le 
types .mp3, .jpg, .avi, etc. That is, it displays only the fi le types that it 
knows how to play. To see all your fi les, including ones it cannot play, 
change the Show all fi les system setting to On. Files that it cannot play 
will be preceded by the unknown fi le type icon .

File Operations Folder Operations

Info:  Show fi le information such as song length, video length, photo 
size, number of kilobytes used of hard disk space, date fi le was 
made, etc.

Delete:  Delete the fi le permanently from the Gmini 400. (Before it is 
deleted, the Gmini 400 will ask “Delete fi le: xxxxx ?”. Use the 
function keys to reply Yes or No. For folder, it will delete the entire 
contents of the folder. It will ask “Delete folder: xxxxx and all 
fi les therein?”. Use the function keys to reply Yes or No.
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Rename:  Change the name of the file or folder to something new. You 
will be sent to the virtual keyboard (see next section) to enter 
the new file or folder name.

Create:  Create a new folder in the current level of the directory. You 
will be sent to the virtual keyboard (see next section) to enter 
the new folder name.

Copying and Moving Files and Folders

By using the unique Archos double browser system, you can copy or move 
files from one location in the file structure to another (1000 files per folder 
maximum). You simply click on the RIGHT button, and a second browser 
window will open. The double browser can be used in:

Photo View:  Left browser shows the memory card and right browser 
the Gmini 400 hard disk.

Music View:  Left browser is the Gmini 400 hard disk and right 
browser the music Playlist.

Browser View: Two browser windows to browse two different parts of 
the Gmini 400 hard disk.

In the Browser mode, you can jump between the two windows using the 
LEFT and RIGHT buttons. Where the cursor is highlighting a file or folder, 
that window is the source for the copy. The destination folder will be the 
other window. For example, we want to copy the file Project X.doc from 
the HD/Data/Files from Work folder to the HD/Data/Backed up 
Files folder. We must start from the main screen Browser  mode.

 

1) Locate the file to copy. 2) Click the RIGHT button to open a 
new browser window.
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3) Click the RIGHT button again to 
move the cursor to the right browser 
and fi nd the desired destination folder.

4) Move back to the left browser (LEFT 
button), highlight the fi le to copy, and 
select copy from the fi le menu. The 
fi le will be copied to the folder in the 
right browser. Entire folders can also be 
copied or moved in this same manner.

12.3 Using the Virtual Keyboard

It is recommended that you create folders and rename fi les or folders 
from your computer when it is connected to the Gmini 400. The computer 
keyboard is much easier. Often times, however, you are not near your 
computer and you must enter the text directly with the Gmini 400. For 
this, the virtual keyboard screen will appear.

The new text that you are typing in Cursor

Each key has an upper case and lower case 
character (lower case mode shown here). 

Press ENTER ► to enter the highlighted key.

Hold down on the LEFT or RIGHT buttons to 
move the cursor within the line.

Change keyboard between upper case and 
lower case

Confi rmation to use the entered text Backspace button
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Note that when the Gmini 400 is connected to a computer, it will use 
more energy than usual. Your battery power will be consumed at a higher 
rate than normal. If the Gmini 400 looses power while connected to your 
computer you could damage your directory structure and/or loose data. 
Thus, you should always use the AC adapter when connected to your 
computer. Be careful to understand the disconnection procedure also since 
disconnecting incorrectly can lead to data loss or computer/Gmini freeze 
up. The Gmini 400 is not compatible with Windows® NT, Windows® 95, or 
Windows® 98 (fi rst edition). Windows 98SE® (second edition) drivers are 
available on the Archos web site. While connected as a hard disk to your 
computer, the Gmini 400 buttons are blocked and are no longer functional.

13.1 Connecting the Gmini 400

1) Use the power adapter to prevent the Gmini 400 from shutting off due 
to low power. (This could cause damage to the contents of the hard 
disk if not done.) 

2) Plug the USB cable into your running computer.
3) Turn on the Gmini 400 – wait until it completely boots up.
4) Plug the other end of cable into your now running Gmini 400. 

Windows® ME, 2000, XP (Home/professional)

When connected, the Gmini 400 will be 
recognized as a Mass Storage Device and 
display automatically within a few seconds 
of being connected. You will see a new drive 
letter, such as E: in My Computer called 
JUKEBOX. You can now use the hard disk 
called JUKEBOX like any other external 
hard disk. Simply access it using Windows® 
Explorer to drag and drop fi les to and 
from the Gmini 400’s hard disk. If it is not 
automatically recognized, please refer to the 
troubleshooting section at the back of this 
manual. 

13 Connecting/Disconnecting the Gmini 400  
 to/from your PC
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Macintosh™ OS 9.X 

You must update your operating system to a minimum 
of version 9.2. Once done, you will not need any 
special drivers or extensions. You simply plug the 
Gmini 400 into your Macintosh as enumerated above, 
and within a few seconds, the Gmini 400 will be 
recognized as a mass storage device (Hard Disk) and 
mount on the desktop. You can now use the Hard disk 
called JUKEBOX like any other external hard disk.

Macintosh™ OS X

We highly recommend that you update to Macintosh OS 10.2.4 
or later. If you have Mac OS X before the 10.2 upgrade, you will find that 
version 10.1 may mount the Gmini 400 as a hard disk on your desktop, 
but ONLY after a very long wait, up to 10 minutes. Version 10.0 of OS X 
does not have the ability to properly recognize a mass storage device such 
as the Gmini 400.

Macintosh™ OS X (10.2 Jaguar and 10.3 Panther)

If you have OS 10.2, you must update to version 
10.2.4 or newer. This is a free update from Apple® 
Computer. You will not require any special installation 
of software drivers or extensions. You simply plug the 
Gmini 400 into your Macintosh as enumerated above, 
and within a few seconds, the Gmini 400 will be 
recognized as a mass storage device (Hard Disk) and 
mount on the desktop. You can now use the Hard disk 
called JUKEBOX like any other external hard disk.

13.2 Disconnecting the Gmini 400 from your Computer

WARNING: You must properly remove (unmount) your Gmini 400 from 
the computer before disconnecting the USB cable to avoid loss of data or 
freezing the computer and/or the Gmini 400. 

DO NOT SIMPLY PULL OUT THE USB CABLE AT ANY TIME!
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Windows® 

To safely disconnect the Gmini 400 hard disk, click on the system tray 
remove icon (green arrow as shown below) and follow the instructions. 
Wait until you get a message saying that you can safely unplug the device 
before disconnecting the USB cable. Attention: The operating system will 
not allow you to safely disconnect the Multimedia Gmini 400 if you have 
an open fi le from it in a running application. You will have to close all open 
Gmini 400 fi les in any running application. Sometimes, even when fi les are 
closed in an application, you will have to shut down the application. Using 
the green disconnect arrow in the system tray will then allow you to safely 
disconnect the Gmini 400.

1. The safe remove icon is in the system tray next to the clock.

                                

Windows® XP               Windows® 2000 & Windows® ME

2. Click on the icon to eject (unmount) the Gmini 400 from the computer and 
select the ‘Safely remove’ message. 

 

 Windows® XP & 2000

3. There will be a message indicating that it is now safe to disconnect the Gmini 
400. You can now go ahead and unplug the USB cable from the Gmini 400.

           

 Windows® XP                                Windows® 2000

Note: Hitachi_DK23DA-20 only indicates the type of hard disk used inside of the Gmini 400.
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Macintosh®

Drag the Gmini 400 hard disk icon towards the 
trashcan, the trashcan will become a big arrow as 
shown in the screen shot to the left (Mac OS 9.x will 
still retain the trashcan icon. This is OK, don’t worry.) 
Drop the hard disk icon onto the arrow (or trashcan). 
The hard disk icon will disappear from the desktop. 
You can now safely unplug the USB cable from your 
Gmini 400 and/or computer.
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14 SETTINGS

From the home screen, select the Setup option to reveal the menu 
options for various settings.

14.1 Sound Settings

If you would like to customize the sound quality, you can adjust 
the Bass, Treble, and other audio settings to suit your particular 
taste. Normally you will do this while listening to music so that you 
can hear the changes you make. Simply click on the LEFT function 
button Setup while listening to music.

• Once in the Setup screen, move 
over to the Sound icon and click 
again on ENTER ►. Use LEFT and 
RIGHT to change a parameter’s 
value. You will hear these changes 
instantly.

• Use the UP and DOWN buttons to 
select a different parameter.

• Click on STOP/ESC when finished. 
You will return to the Setup screen.

• Click on STOP/ESC again and you will return to the music playing screen.
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The Sound Parameters

Parameter Description

Volume 32 levels of volume (0-31). 

Bass 10 levels. Decreases or Increases the low frequencies.

Treble 10 levels. Decreases or Increases the high frequencies.

Balance 10 levels. Favors the right or left channel of the Stereo signal

Bass Boost 10 levels. Increases the very low frequencies

Reset button Readjusts all settings to their default values

14.2 Play Mode Settings

If you would like the Gmini 400 to play through an entire folder of 
songs, play songs at random (shuffle), or any of the other playing 
options, you can set these parameters in the PlayMode settings.

• Click on STOP/ESC to return to the Gmini 400 main menu and click 
on Setup. Or, while listening to a song click the LEFT function button 
Setup. 

• Once in the Setup screen, move over to PlayMode and click again on 
ENTER.

• Highlight one of the five PlayModes and click on ENTER to check that 
option. 

• With the Repeat & Shuffle setting, choose if the songs are to be 
played in order, repeated or shuffled.

• See section 3.4 for details on using 
the ARCLibrary 

• Picture Pause sets the amount of 
time paused between pictures in 
the slideshow mode. See the Photo 
chapter for more details.
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Play Mode

Gmini 400 is currently playing from a Playlist 

Folder: Play all tracks in the current directory

All: Play all tracks on Gmini 400 

Single: Play a single track then stop

Queue: User can queue the next track to be played † 

Scan: Gmini 400 plays first 15 seconds of each track††

†Queue Mode: While the current song is playing, click on Navigate, find the next song you want 
to play, then click Play. This is your queued song. You can only queue one song at a time. See the 
Playlist section to prepare multiple songs to play. Once the current track is finished playing, your 
queued track will be played. If you do not queue another track at this time, the Gmini 400 will play 
the next song in the directory.

††Scan Mode: Each track in the directory is played for 15 seconds. This allows a quick sample 
of each song. If you want to play the whole song, click on the Play button during those first 15 
seconds. The Gmini 400 will then revert to folder mode and play the rest of the songs in the folder 
without scanning.
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14.3 Clock Settings

The Gmini 400 has an internal real time clock. 
The time of day is shown on the top right of 
the screen in either 24 hour or 12 hour display 
mode. To set it, go to Setup then select Clock. 

Choose parameter Choose Value for 
highlighted parameter

When fi nished setting the parameters, move down to the Set button, then 
click on the ENTER/GO button. The clock time and date are now set. Click 
on the STOP/ESC button to go back to the main settings menu.

14.4 Display Settings

These settings regulate the interface language and the presentation 
of the screen.
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Setting Description

Language The Gmini 400 can be set to English (default), French, German 
or Spanish.

TV Standard NTSC (USA), PAL (Europe). In order to view images or vid-
eos on an external television, select one option to send the 
video signal compatible with your country’s television system. 
Countries other than European or American will use one of 
these two systems. 

Video Output Internal LCD or External TV. To display via the built-in LCD 
screen or to view the display via an external television. Hold-
ing the F2 function button for three seconds will also alternate 
between these two options. Be sure your television is selecting 
the correct external input.

Image Display Interlaced, Progressive. This is the way the video output will 
be sent to the television. When viewing still images (JPEG and 
BMP) on a television screen, set this to Progressive to reduce 
possible flickering in the image.

Appearance Change the interface appearance

Setting Description

Wallpaper On, Off. When set to On, the selected picture (next item) will 
be displayed as the Gmini 400 screen background.

Picture name This option will display the names of the JPEG images in the Gmini 
400’s System folder that can be used for screen backgrounds 
(Wallpaper). You can add your own JPEG images to the System 
folder by dragging and dropping a JPEG file from your computer. 
You should use JPEG images with small dimensions, ideally 320 
x 240 pixels (large files slow down the display).

Font Outline If your screen background is a dark color, it will be difficult to 
see the black text on the screen. Set Outlined font to On to 
have a more visible white outlined font.

Color scheme Allows you to choose what color you would like to have for the 
status bar above and the screen buttons below.

Cursor color Allows you to change the color of the cursor.

Previous settings Click this button to return to the settings last set.
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14.5 Power Settings

These settings will help you to save battery power thus allowing a 
longer battery autonomy.

You can set the Gmini 400 to conserve 
power for both modes of operation 
(when it is powered from the battery, or 
when it is connected to the AC charger/
adapter (DC-Power operation).

Parameter Description

Power Off 1-9 minutes (and Never for DC operation). The number 
of minutes of user inactivity (no buttons pressed) before the 
Gmini 400 shuts off. During the playback of MP3 and AVI 
files, this setting takes effect only after the files are finished 
playing. 

Backlight Off 10-90 seconds, Never. The time of user inactivity (no 
buttons pressed) before the Gmini 400 turns off the screen to 
conserve power. During playback of slideshows and AVI files, 
this setting only takes effect once it is finished playing.

Hard disk 10-90 seconds. The number of seconds from the time of 
the last file access before the Gmini 400 tells the internal hard 
disk to stop spinning. The longer this time is set, the more 
often the hard disk is turning and the quicker the response 
time when accessing files. However, as it is set longer, it will 
quickly consume your battery. Caution: This setting should 
only be changed by experienced users.

A typical use of these settings is to set the power off, screen off, and hard 
disk to low values when used in battery mode. When the power adapter 
is plugged in, you do not need to conserve energy and thus keeping 
the Power on and the Backlight on makes using the Gmini 400 more 
agreeable. Increasing the hard disk value beyond the default may actually 
discharge the battery even when the Charger/adapter is plugged in. Note 
also that your unit will run hotter when the backlight and hard disk are on 
for long periods of time.
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14.6 System Settings

The System settings allow 
you control over the low level 
parameters of the Gmini 400.

Parameter Description

Show all files Off (default), On. If set to Off, the Jukebox will only display 
the file names of file types, with their corresponding icons, 
that it knows how to play. If set to On, the Jukebox will 
display the names of ALL the files on the hard disk (using 
a ? icon for unknown types), even if they cannot be viewed 
or played, such as .tif or .pdf for example. This setting 
is important when inserting memory cards into the 
CompactFlash™ slot. Setting it to ON will allow the Jukebox 
to transfer all the files from the card media regardless of file 
type. If set to OFF, it will only display file types that the Gmini 
400 is capable of playing.

Update Firmware Used to update the Gmini 400 to a new version of the 
Operating System. See chapter 15.

Firmware Version Displays the current version of the Operating System (OS).

Product Key Each Gmini 400 device has a unique product key number. It is 
an ID needed for plug-ins and games.

Hard Disk Displays the amount of free and used space on the Gmini 
400’s hard disk. The total is less than 20 GB due to space 
taken by formatting.
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15 Updating the Gmini 400 Firmware    
 Operating System (OS)

Archos periodically updates the Operating System (OS) and makes 
it available for free download on the ARCHOS website (www.archos.
com). Updates to the Operating System include new features, feature 
improvements, and bug fixes. You should check to make sure that you 
are running the most recent version of the OS. Each time the Gmini 400 
starts up, the OS version is displayed on the screen (example: OS Version 
1.1) on the bottom right. You will find the most recent version of the OS 
and its version number at the Archos website (www.archos.com) under 
the category Software. 

Download the Update_Gmini400.AOS file

When you click on the link to 
download the new OS file (the file 
name is Update_Gmini400.AOS), 
your browser may warn you that the 
contents of the download may harm 
your computer. This is because the 
Windows® system does not know 
what a .AOS file is. Be assured that 
Archos has made every effort to 
ensure that the file does not contain 
viruses. Click on the option Save to 

download this file to a convenient place, such as My Documents, in order 
to later copy this file to your Gmini 400. If your Gmini 400 is connected to 
your PC, you can even save it directly to the Gmini 400.

Read the History.txt File

You will also find next to the firmware download, a text file which details the 
list of changes from the previous version of the OS.

Copy to Gmini 400 root and Update

When updating your Operating System, you must keep the AC charger/
adapter plugged into the Gmini 400 so that it will not shut down due to 
low batteries while you are performing the update. Connect your Gmini 
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400 to your computer (section 
16.1), and then copy the 
Update_Gmini400.AOS file to 
the root directory of the Gmini 
400. The root directory is the 
top most level of the directory 
hierarchy. Just drag this .AOS 

file onto the Gmini 400 Hard disk in your file manager and it will place it 
in the top most directory (outside any folder). If there is already an older 
version of the Update_Gmini400.AOS file on your Gmini 400, Windows® will 
ask if you want to overwrite the current file. Click on Yes. Once this file is 
copied, safely disconnect (section 13.2) the Gmini 400 from the computer. 

Next, go to the System parameters under Setup and then scroll down to 
Update Firmware and click on it. The Gmini 400 will search for the .AOS 
file and will ask you to click Yes, to start the update. Follow the on-screen 
instructions. When completed, the Gmini 400 will restart itself and you will 
see the new OS version displayed on the bottom right of the screen. 
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• For warranty and services purposes, keep your sales receipt for proof of 
purchase.

• If technical support (Telephone or E-mail) determines that your product 
needs to be returned, please contact the place of purchase to have your 
product repaired or replaced (depending on problem type). Customers 
who purchased directly from the Archos website should fill out the form 
on the website under Support: Product Returns.

• There is an FAQ – Frequently Asked Questions section at the ARCHOS 
Website www.archos.com, Support: FAQ that can help answer many of 
your questions.

• If you need technical help, you may contact ARCHOS directly in your 
own language via these phone numbers. For other countries, please 
use e-mail technical support.

------------Telephone Support--------------------------------------------
DO NOT USE PHONE SUPPORT FOR MARKETING AND 
SALES QUESTIONS. These numbers are to aid those 
who have technical difficulties / malfunctions.

949-609-1400 (USA, Canada)

01 70 20 00 30 (France)

0207-949-0115 (UK)

069-6698-4714 (Germany)

09-1745-6224  (Spain)

02-4827-1143 (Italy)

020-50-40-510 (Netherlands)

------------E-mail Support-------------------------------------------------
tech-support.us@archos.com   English (United States and Canada customers)
tech-support.eu@archos.com  English or French (Europe and the rest of the planet)
tech-support.de@archos.com  German (Germany)

To respond to your e-mails efficiently, when sending one, please indicate 
the product name and question type in the Subject of the e-mail. 

For example:
To: tech-support.us@archos.com
Subject: Gmini 400 – Playing a Playlist

16 Technical Support
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WWW.ARCHOS.COM

Worldwide Offi ces

United States & Canada Europe & Asia

ARCHOS Technology
3, Goodyear - Unit A
Irvine, CA 92618 USA
Phone:  1 949-609-1483
Fax: 1 949-609-1414

ARCHOS S.A.
12, rue Ampère
91430 Igny
France
Phone: +33 (0) 169 33 169 0
Fax: +33 (0) 169 33 169 9

United Kingdom Germany

ARCHOS (UK) Limited
3 Galileo Park
Mitchell Close
West Portway Andover
SP103XQ Andover
United Kingdom
Phone: +44 (0) 1264 366022
Fax: +44 (0) 1264 366626

ARCHOS Deutschland GmbH
Bredelaerstrasse 63
40474 Düsseldorf
Germany
Tel: +49 211 1520 384
Fax:  +49 211 1520 349
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17 Troubleshooting

17.1 USB Connection issues

Problem: I cannot get my Gmini 400 to be recognized by the computer.
Solutions:
• Shut off and reboot the computer and the Gmini 400 and then try 

connecting again in the preferred order mentioned in section 13.1.
• Only if using Windows 98SE, you must first install the Windows98SE 

drivers.
• If you installed the Windows 98SE driver on your Windows® XP, 2000, 

or ME edition, this could cause problems. Uninstall that driver and then 
reinstall the generic Windows® Mass Storage Device driver.

• If using a USB hub, try connecting without using the hub (some hubs 
are not powered and may not work with the Gmini 400).

• If using a USB port in the front of your computer, try a USB port in the 
back. Front USB ports are often from non-powered hubs.

• Do not connect to a USB port repeated through a keyboard.
• On old computers, the USB driver software on your computer may be 

out of date. Find your USB chipset type by going to My Computer > 
Properties > Device Driver > Universal Serial Bus (USB) Controllers > 
Host Controller. You may have a chipset VIA, Intel, SIS or another. It 
is possible that you do not have the latest software drivers for these 
chipsets. For VIA updates, check out www.viaarena.com. For Intel 
check out www.intel.com. For SIS, uninstall the driver and reinstall the 
Windows default USB controller drivers. 

• If using a laptop computer and a docking station, try connecting 
without the docking station.

• If Macintosh® OS 10.1.x says it cannot mount the volume, you can use 
Disk Utility to reformat the Jukebox hard disk to type MS DOS FAT32. 
However, files will only be readable from a Macintosh®, not a Windows® 
machine. You should update to version 10.2.4 or better. 

• On older computers, make sure in your system BIOS the USB port is 
checked “ON” not “Off”. Usually this just happens on old machines.

• On older Win98SE computers, if there is a line “lastdrive=” in the 
config.sys file, make sure that it is “lastdrive=z”.

• If the Files Allocation Table (FAT) gets corrupted, the Gmini 400 may 
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not show up in Windows XP for over one minute, and then it comes up 
as local drive. Use DOS Utility ChkDsk as shown below. 

• Windows® XP may recognize the Gmini 400 hard disk but yet not assign a 
drive letter to it. Right click on My Computer and select Manage. Then 
select Storage, then Disk Management. Within this window you may 
see the hard drive and be able to assign a drive letter by right-clicking 
on the hard disk, and selecting the option Change drive letter and 
paths… 

Problem: What do I do if I try to disconnect via the green arrow but keep 
getting “The device ‘Generic Volume’ cannot be stopped now. Try stopping 
the device again later.”
Answer: Shut off any program that might be accessing data on the Gmini 
400, including Windows® Explorer. If this does not work, shut down all 
programs, wait 20 seconds, then try the green arrow one or two times 
again. If this does not work, you should shut down the computer and 
disconnect the USB cable once the computer is off. 

17.2 Charging and Power issues

You do not need to fully discharge the batteries before recharging them. 
Problem: A full battery charge does not last as long as the specifications 
suggest. 
Answer: The specifications are under the condition that the screen 
backlight goes off after 30 seconds (for MP3 music) and the user does not 
access the machine, it just sits and plays. If you get significantly less time 
from a full charge, call our technical support hot-line.

17.3 Gmini 400 locks up (freezes operation) or Stops

Problem: The Gmini 400 locks-up. None of the buttons work.
Solution: If the lock buttons is set, none of the buttons respond. Hold 
down the F1 function button for three seconds to turn off the lock buttons 
function. A freeze up could also be caused by electrostatic phenomena. 
That is, static electricity has temporarily knocked out the Gmini 400. Hold 
down on the STOP/OFF button for 15 seconds and the Gmini 400 will shut 
off. Restart it normally now. 
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17.4 The Computer locks-up (freezes operation) or Stops

Problem: The computer locks-up. 
Answer: Most likely because you did not use the green ‘safely remove 
hardware’ icon in the system tray in order to remove the Gmini 400 from 
your computer. 

17.5 File issues, corrupted data, formatting, and partitioning

Problem: On the Gmini 400, I find new file names and folder names that 
I never created or they have strange gibberish names.
Answer: Most likely, the Gmini 400’s file allocation table (FAT) has been 
corrupted. This could have been due to the Gmini 400 shutting down 
(due to low battery power) while reading or writing to your computer via 
the USB connection. To fix a corrupted FAT problem, you should use the 
Error Checking utility or the Check Disk utility explained at the end of this 
section. 
Attention: Windows and Macintosh often write extra files to the hard disk 
such as finder.def or System volume info. These are normal and will 
not harm the Gmini 400.

Problem: I have been using my Gmini 400 to transfer files back and forth 
between different computers. Will defragmenting the Gmini 400 hard disk 
do any harm to it?
Answer: Defragmenting the Gmini 400 hard disk may be useful after 
having transferred many files to and from the Gmini 400. It is never 
harmful to use the defragmenter on the Gmini 400. Make sure no other 
program is running while using the Windows® defragmenter utility. Make 
sure you power the Gmini 400 with the external power adapter during 
this procedure.

Problem: I have copied files to my Gmini 400 via USB from my computer, 
but now I cannot see these files on the device.
Answer: You have probably transferred a file which the Gmini 400 cannot 
play, for example a PDF, MOV, or DOC file. Go to the System Settings 
under Setup on the main screen and you will find a parameter called 
Show all files. If you set it to on, the Gmini 400 will show all files, even if 
it cannot play the file (you must browse via the browser mode from the 
main menu screen). The browser will show a ? icon indicating that it is not 
one of the standard file types that it can play.
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Problem: I want to reformat the Gmini 400’s hard disk.
Answer: You can do this, but it will erase ALL of the data on your Gmini 
400. Sometimes this may be necessary if your FAT (File Allocation Table) 
becomes so corrupted that nothing seems to fix your file problems. First, 
as explained below, you should run ScanDisk or the DOS chkdsk (Check 
Disk) program to try to fix your problem. If this doesn’t fix your problem 
and you are sure you must reformat the Gmini 400 hard disk, then go to 
the screen Setup > System and press and hold the Right function button 
for three seconds. A button “Format HD” will appear. Use this button to 
format the Gmini 400’s hard drive. Remember, doing this will erase all the 
data on the hard disk!!!

Problem: I would like to partition the Gmini 400 hard disk. 
Answer: If you know how to partition a hard disk, this is OK. The Gmini 
400 will, however, only recognize a FAT32 partition. Thus it will just see 
and use that partition of the hard disk which is a FAT32 partition. 

Problem: My files have disappeared from the Gmini 400.
Answer: To see all your files, make sure the setting Show all files is set 
to ON. Also make sure that you browse your files via the Browser mode 
and not a filtered view such as Photo, Music, or Video.

Windows® 98SE & ME Running Scan-Disk (Error Checking)

• Quit all running applications.
• Properly connect the Gmini 400 to your computer as explained in chapter 13.
• Make sure external AC adapter is powering the Gmini 400.
• Right click on the Gmini 400 hard disk in Windows® Explorer and select 

Properties.
• Select the Tools option and run the Error checking program
• Make sure you check the box to automatically fix errors.
• Be patient, this may take a while. Windows® may ask you to restart the 

computer to make certain Windows files available. This is OK, click on Yes.
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Windows® XP & 2000 Running Check Disk Utility (ChkDsk) 

If you still have problems with the file system on your Gmini 400 you can 
try to fix it using the DOS utility, check disk (chkdsk). Do the following;
• Make sure external AC adapter is powering the Gmini 400.
• Quit all running applications.
• Properly connect the Gmini 400 to your computer as explained in chapter 13.
• Wait patiently (up to 5 minutes) for Windows XP to show the local drive 

as mounted.
• Open a DOS window. Programs > Accessories > Command Prompt.
• At the prompt, type chkdsk e: /f. Use e: or f: or whatever drive letter 

is representing your Gmini 400. The /f argument tells the program to 
automatically fix errors.

• Be patient, this may take a while.
• When it is finished, exit the DOS Window and properly disconnect the 

Gmini 400 from your computer.
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ARCHOS VIDEO Gmini 400 series 
Storage Capacity 20 GB*

Computer Interface High Speed USB 2.0 (compatible USB 1.1) 

Image Playback JPG and BMP (4, 8, 24 bit) images, any size

Audio Playback Stereo MP3 decoding 30-320 kb/s CBR & VBR, WMA, WAV.

Audio Recording Analog stereo WAV (PCM & ADPCM) - SPDIF not supported

Video Playback Video track: MPEG-4 Simple Profile compliant .AVI format (reads 
DivX®** 4.0 & 5.0 & XviD) up to 640x400 pixels @ 30fps or 640x480 
@ 25 fps. 
Sound track: MP3 or WAV (IMA-ADPCM) 

Screen Color TFT LCD 220 x 176 pixels 262 thousand colors

Television Video output in PAL (EU) or NTSC (US) standard

Playback Autonomy*** Up to 10 hours audio and up to 5 hours video

Scalability Free Operating System updates downloadable from ARCHOS website

Ports CompactFlash™ slot to read CompactFlash™ type I memory cards

AV Connections Audio/video Multi-connect jack. Includes connections for audio IN 
and audio/video OUT.

Power source Non-removable internal Lithium-Ion battery pack. 
External charger/adapter.

Physical Dimensions 106 x 60 x 18 mm (4.2 x 2.4 x 0.70 inches) - 160 grams (5.7 oz)

Temperature Range 5 °C to 35 °C running ; -20 °C to 45 °C storage

System Requirements PC: Windows ME, 2000, XP - Pentium II 266MHz with 64MB ram 
Mac: OS 9.2 or X (10.2.4), iMac, G3 or higher 

*1 GB = 1 billion bytes, formatted capacity is less.
**Files compatible with MPEG4-SP AVI only ; MPEG-4: ISO/IEC standard by Moving Picture 
Experts Group ; AVI: audio/video file container by Microsoft. DivX® is a registered trade 
mark of DivXNetworks Inc.  
***Depending on usage (stop/start/power settings)
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Warranty and Limited Liability
This product is sold with a limited warranty and specific remedies are available to the 
original purchaser in the event the product fails to conform to the limited warranty. 
Manufacturer’s liability may be further limited in accordance with its sales contract.
In general, the manufacturer shall not be responsible for product damages caused 
by natural disasters, fire, static discharge, misuse, abuse, neglect, improper handling 
or installation, unauthorized repair, alteration or accident. In no event shall the 
manufacturer be liable for loss of data stored on disk media.
MANUFACTURER SHALL NOT BE LIABLE FOR ANY SPECIAL, INCIDENTAL 
OR CONSEQUENTIAL DAMAGES. EVEN IF INFORMED OF THE POSSIBILITY 
THEREOF IN ADVANCE.

ARCHOS licensor(s) makes no warranties, express or implied, including, 
without limitation, the implied warranties of merchantability and fitness 
for a particular purpose, regarding the licensed materials. ARCHOS’s 
licensor(s) does not warrant, guarantee or make any representations 
regarding the use or the results of the use of the licensed materials in 
terms of its correctness, accuracy, reliability, correctness or otherwise. 
The entire risk as to the results and performance of the licensed materials 
is assumed by you. The exclusion of implied warranties is not permitted by 
some jurisdictions. The above exclusion may not apply to you.
In no event will ARCHOS’s licensor(s), and their directors, officers, 
employees or agents (collectively ARCHOS’ licensor) be liable to you for 
any consequential, incidental or indirect damages (including damages 
for loss of business profits, business interruption, loss of business 
information, and the like) arising out of the use of inability to use the 
licensed materials even if ARCHOS’ licensor has been advised of the 
possibility of such damages. Because some jurisdiction do not allow the 
exclusion or limitation of liability for consequential or incidental damages, 
the above limitations may not apply to you.

Please see your sales contract for a complete statement of warranty rights, remedies 
and limitation of liability.

Furthermore, warranty does not apply to:

1. Damages or problems resulting from misuse, abuse, accident, alteration 
or incorrect electrical current or voltage.

2. Any product tampered-with or damaged warranty seal or serial number label.
3. Any product without a warranty or serial number label.
4. Batteries and any consumable items delivered with or in the equipment.
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Warnings and Safety Instructions
CAUTION
To prevent risks of electric shock, this unit must only be opened by qualified service personnel.
Power off and disconnect the power supply cable before opening the unit.

WARNING
To prevent fire or shock hazard, do not expose the unit to rain or moisture.
Use of this product is for personal use only. Copying CDs or loading music, video, 
or picture files for sale or other business purposes is or may be a violation of 
copyright law. Copyrighted materials, works of art, and/or presentations may require 
authorization to be fully or partially recorded. Please be aware of all such applicable 
laws concerning the recording and use of such for your country and jurisdiction.

SAFETY
For driving safety, only a passenger should operate the device when the car is in 
motion and not the driver. Laws governing the usage of electronic devices by the 
driver may be applicable in your jurisdiction and/or country. 

FCC Compliance Statement
FCC Compliance
This equipment has been tested and found to comply with limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with instructions, may cause harmful interference 
to radio communications. However, there is no guarantee that interference will not 
occur in a particular installation. If this equipment does cause harmful interference 
to radio or television reception, which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the interference by one or more 
of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

CAUTION: Modifications not authorized by the manufacturer may void users 
authority to operate this device.

FCC Part 15 - Operation is subject to the following two conditions:
1. This device may not cause harmful interference;
2. This device must accept any interference received including interference that may 
cause undesired operation.
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Electrostatic Discharge
Note: During electrostatic discharge, the product may be malfunctioning. Reset to 
return normal operation. The Gmini 400 reset is actuated by pressing and holding 
the STOP/ESC button for 10 seconds. The unit will power off. Restart normally.

Copyright Notice
Copyright ARCHOS © 2004 All rights reserved.
This document may not, in whole or part, be copied, photocopied, reproduced, 
translated or reduced to any electronic medium or machine-readable form without 
prior consent, in writing, from ARCHOS. All brands and products names are registered 
trademarks and the property of their respective owners. Specifications are subject to 
change without notification. Errors and omissions accepted. Images and illustrations 
may not always match contents. Copyright ® ARCHOS. All rights reserved.

Disclaimer of warranty: to the extent allowed by applicable law, representations and warranties 
of non-infringement of copyrights or other intellectual property rights resulting from the use of the 
product under conditions other than as here above specified, are hereby excluded.

LCD Pixel Policy
The LCD screen on your Archos Gmini 400 unit has been manufactured to rigorous 
standards to provide a high quality viewing experience. Nevertheless, your LCD 
screen may have slight imperfections. This is not particular to the Archos screen, 
but to all devices which have LCD screens regardless of the original manufacturer of 
the LCD. Each product vendor guarantees that his screen will contain no more than 
a certain number of defective pixels. Each screen pixel contains three dot elements 
(Red, Blue, and Green). One or all of the dots in a given pixel may be stuck on or 
stuck off. A single dot stuck off is the least noticeable. All three dots of a pixel stuck 
on is the most noticeable. Archos guarantees that its Gmini 400 screen will have no 
more than 1 defective pixel (regardless if that pixel has one or more defective dots). 
This means that during the period of guarantee for your country or jurisdiction, if 
the screen on your product has two or more defective pixels, Archos will repair or 
replace your AV400 product at its cost. Thus, one defective pixel is not grounds for 
replacement or repair of the product.

Avoiding Hearing Damage
This product respects the current regulations for limiting the output volume of 
consumer audio devices to a safe level. By listening to your device with headphones 
or earbuds at high volumes, you run the risk of permanent damage to your ears. 
Even if you get used to listening at high volumes and it seems normal to you, you 
still risk the possibility of damaging your hearing. Reduce the volume of your device 
to a reasonable level to avoid permanent hearing damage. If you hear ringing in your 
ears, reduce the volume or shut off your device. This device has been tested with the 
Archos supplied earphones. Other manufactures earphones may produces volume 
levels higher or lower than the Archos delivered earphones.


